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Random Notes at End of This QRG 

KnowItAll for MS and GC/MS 
Opening Display 
Upper Left Corner (Depends on closing) 

 

Selected Item (   Spectral Analysis   ) on top and 
bottom of display (Other three options appear 
between the two displays of   Spectral Analysis.   ). 

Icons pertain to lower and top item on the Top part of 
the page. The Primary Functions for selection will 
move between the top and bottom of this column on 
the Desktop based on what is selected, i.e., when 
Basics   is selected,   Data    ,  Spectral Processing  , 
and   Spectral Analysis    will appear on the bottom 
and only   Basics   will appear at the top. 

Right side of Desktop only changes when an icon 
under a selected Primary Function is selected. 

Spectral Analysis  does not have selections used 
for MS or GC/MS Data.  

Basic    button has ChemWindow (for drawing 

Structures ), ReportIt (for drawing chemical 

reactions, ) and BrowseIt (returns to opening 

promotional screen, ). 

Data    selection has two selections recommended 

for GC/MS and MS, MineIt/Create Databases ( ) 

and SearchIt ( ) for individual mass spectra. 

Spectral Processing   is the primary selection for 

GC/MS and MS with the options of ProcessIt ( ) 
and MS Expert ( ). MS Expert is not explained in 
the Quick Reference Guide. 

Important Notice 
The first time the MineIt window is displayed, select 
View from the Main Menu Bar. Make sure that there 
is a check mark () next to the Implicit Hydrogens 
selection. 



GC/MS Data Analysis 
ProcessIt window 
After selecting    Spectral Processing    , put the 
Mouse pointer on the ProcessIt icon ( ) and Click 
the left Mouse button (LMB). In the upper left 
corner of the ProcessIt window is a button labeled 
Open Data File (                      ). Put the Mouse 
pointer on this button and single Click the LMB. This 
causes a File Section dialog box to be displayed. 
Navigate to the name of the desired GC/MS data 
file. Put the Mouse pointer on the name of the 
GC/MS data file to be viewed and Click the LMB 
once. A preview of the RTIC chromatogram will 
appear in the lower part of the dialog box. Put the 
Mouse pointer on the button labeled Open and Click 
the LMB once to open the file in the ProcessIt 
window. 

KnowItAll recognizes most instrument 
manufactures GC/MS formats. If not, export the data 
file in the AIA format (*.CDF; netCDF file). 

The display changes to four widows. The vertical 
window on the right is the Text Information 
contained in the data file. This window can optionally 
be closed. Just Click on the X box in the upper left 
corner. To re-open, select View in the Main Menu 
Bar. On the View menu highlight Properties Table 
and Click the LMB. 

The three horizontal windows on the left side of the 
Properties Table are: Top, reconstructed total ion 
current (RTIC) chromatogram; Middle, the mass 
spectrum of wherever the Mouse pointer is located 
on the RTIC chromatogram; and Bottom, the 
selected spectrum. 

The Mouse Pointer will have 
different images depending 
on the selected function. The 
functions can be assigned 
by using the Right Mouse 
Button (RMB) menu that 
can be displayed when the 
pointer is in one of the three 
horizontal windows. The selected function is 
designated by the • symbol on the left edge. There 
are also buttons above the Top window to change 
the Mouse pointer to some of its functions. Passing 
the Mouse pointer over these buttons will show 
(Tool tips) that indicate what option can be selected. 
Only some of the RMB menu selections can be 
assigned by click on one of these buttons. 

Mass Chromatograms (Extracted Ion 
Chromatograms, EIC) 
Mass Chromatograms (EIC) can be displayed along 
with RTIC chromatograms. Currently, this is limited 
to single m/z values. Feature versions of KnowItAll 
will also allow for sums and ranges of m/z values.  

Click on Process in the Main 
Menu. From the Process menu 
select Selected Ion… This 
results in the display of a dialog 
box. Enter values, one at a time, 
in the box under the label Enter 
an Ion: and then click on the 
Add button. The box will clear, 
and the number will appear in the 
window with the Selected Ions: 
label, on the left side of the box dialog. Do Not press 
the <Enter> key after entering the number. This will 
close the dialog box and the entered number will not 
be retained. Add additional numbers to the list by 
repeating the above process. Once all numbers have 
been added, click on the OK button. If you want to 
cancel the display of any EIC, redisplay the dialog 
box, highlight the value(s) in the list and click on the 
Remove button. 

By default, the RTIC and EIC(s) will be presented in 
a stacked display in the Chromatogram window with 
the RTIC Chromatogram on the bottom. The 
intensities of the peaks in the EIC(s) will be relative to 
the most intense peak in the RTIC chromatogram. 
The display can be changed to an overlay by 
selecting the Overlay button (    ) in the button bar 
just under the ProcessIt label. To return the the 
stacked display, select Stacked button (     second to 
right of the Overlay button – look for Tool Tips). 

By default, the Active Chromatogram is the RTIC 
chromatogram. By placing the Mouse pointer, when it 
is in the Select Mode (    ), on one of the lines of a EIC 
and clicking the left Mouse button, will make that 
chromatogram the Active. That chromatogram’s line 
color will turn to that of the Active and the previous 
Active (the RTIC in this discussion) will change to the 
color of the first spectrum in the Edit Properties 
dialog box’s Color and Font tab. Just to the right of 
the Stack button, there are four buttons related to the 
scaling of multiple chromatogram displays; Scale 
Independently (    ); Scale To Active (    ); Scale To 
Largest (    ); and No Autoscale (    ). These buttons 
are grayed unless the Mouse pointer in the select 
mode (     ). 



Selecting Spectra to be Searched 
When the Mouse pointer is a normal arrow (    the 
Select Mode), placing it on a specific position on the 
RTIC chromatogram will cause that spectrum to be 
locked into the Bottom window when the left 
Mouse button (LMB) is Clicked once. 

Averaged spectra can be selected for searching. 
There is a Green-colored Bar labeled AVERAGE 
RANGE BAR at the bottom of the RTIC 
chromatogram window, just under the abscissa 
label. Put the Mouse pointer in this Bar; click and 
hold down the LMB and drag to the right or left to 
paint a region of the chromatogram. All spectra in 
the region will be averaged. The region can be 
redefined by putting the Mouse pointer on either the 
right or left edge of the painted region in the Bar and 
dragging to the right or left while holding down the 
LMB. When the button is released, the adjusted 
margin of that side of the region will be moved. The 
entire range can be move to a different part of the 
chromatogram by putting the Mouse pointer on the 
center part of the region in the Bar, holding the LMB 
down and moving the Pointer to the right or left. 
When the button is released, the new region will be 
painted. Multiple, non-contiguous groups of spectra 
can be averaged. The average spectra ranges are 
painted a light green. 

When the Mouse pointer is in the Select mode, a single 
range of spectra can be selected as an averaged 
spectrum by holding down the LMB and dragging the 
pointer over the region (to the left or right) that is to be 
averaged in the RTIC chromatogram. If this process is 
repeated, the previous averaged is removed. 

Background subtraction: Searching of a background 
subtracted spectra is possible. The range or ranges of 
the background spectra are selected by putting the 
Mouse Pointer in the dark red BACKGROUND 
RANGE BAR at the top of the RTIC chromatogram. 
Selections are accomplished in the same ways as 
Averages are selected and the overall behavior is the 
same.  

At the right end of the AVERAGE & BACKGROUND 
Bars are Trashcan  icons. Putting the Mouse 
pointer on the range in these bars, holding down the 
LMB, and dragging to the  deletes the range. Click 
on the  deletes all the range. 
******************************************************** 

CAUTION 
It is possible to zoom in on a portion of the RTIC 
chromatogram using the Horizontal Zoom Mode or 

Box Zoom Mode selections from the RMB menu. If 
this is done, it may cause a previously selected 
Average Spectrum or Background Range to no 
longer be visible. Be sure to carefully review the 
Title Box in the lower Spectrum window to see if 
multiple averages have been selected for either. 

********************************************************** 
The spectrum in the Bottom window can be sent to 
the SearchIt window by putting the Mouse pointer 
on the SearchIt button in the button bar just below 
the Main Menu Bar and Clicking the LMB. 

 

When the spectrum is sent to the SearchIt window, 
the ProcessIt window is closed and the SearchIt 
window, with the spectrum, is displayed. There will 
be a tab at the bottom of the the display with label 
Search #1 in the SearchIt window. 

The displayed spectrum can be searched by putting 
the Mouse pointer on the Search button in the lower 
right of the Search window and Clicking the LMB 
once OR the ProcessIt window can be re-displayed 
by putting the Mouse pointer on the arrow icon () 
pointing to the left on the left side of the top button 
bar and Clicking the LMB once. Another spectrum 
can then be selected and sent to SearchIt window. 

When the display is returned to the ProcessIt 
window, the previously select background range(s) 
and averaged spectra range(s) are still displayed. 
Putting the Mouse pointer in the RTIC chromatogram 
window and Clicking the LMB once, with the Mouse 
pointer in the Select mode, will clear all the averaged 
range(s). The background range(s) can be removed 
by putting the Mouse pointer in the highlight 
section(s) of the dark red BACKGROUND RANGE 
BAR, Clicking the RMB, and selecting the Yes button 
in the displayed dialog box.  

As many spectra as desired from a single data file can 
be queued by repeating the above processes process. 

NOTE: The displayed spectrum in the bottom window 
of the ProcessIt window can be sent to the NIST MS 
Search Program by selecting Edit from the Main Menu 
Bar and then selecting Transfer to NIST MS Search. 

Selection of Additional Spectra 
Once the ProcessIt window is re-displayed, select 
another spectrum on the RTIC chromatogram in the 
same way as the first spectrum was select. Then 
Click the LMB with the pointer on the SearchIt 
button in the top button bar. 



This time, when the SearchIt window is display, the 
box to the right is displayed.  

Select the Start a new search 
button. The spectrum will be 
displayed and there will now be 
two tabs at the bottom labeled 
Search #1 and Search #2. The 
previous spectrum can be 
displayed by putting the Mouse pointer on the tab 
labeled Search #1 and clicking the LMB. To search all 
the spectra in the queue, select Edit from the Main 
Menu Bar to display the Edit dropdown menu and 
select Do Batch Search.  

The dialog box shown 
on the right is displayed. 
Although not likely, it is 
possible that different 
sets of libraries will be 
associated with each spectrum. If the Yes is selected, 
all the spectra in the queue will be searched using the 
libraries associated with the currently displayed 
spectrum. If No is selected, then each individual 
spectrum will be searched with its associated libraries. 

After all the spectra are searched, the SearchIt window 
will close and the MineIt window will be displayed with 
the Hit List for the last searched spectrum displayed, 
and there will be separate tabs for the Hit List of each 
of the other spectra at the bottom of the MineIt window. 
Click on any tab to display the 
Hit List for the searched 
spectrum, the searched 
spectrum, and the selected Hit 
List spectrum.  

IMPORTANT NOTE 
Under the Search Categories 
section of the SearchIt window 
is Property/Name label next to 
a check box. It is VERY 
important that this check box is 
NOT selected when the 
spectrum is to be searched. 
Any selections in the 
Properties/Name section of the 
SearchIt window can have a 
negative effect on the results of 
the spectrum search. 

All options other than the Spectrum MS (GC) 
should NOT be selected.

Selecting Libraries to Search 
On the left side of the SearchIt window is a section 
labeled Search Databases (midway down the 
column). There is a selected radio button to the left 
of a User-select label. Put the Mouse pointer on this 
label (not the radio button) and Cick the LMB. A 
window is displayed. The top 
part has a list of all available 
libraries for all techniques. At 
the top of this display is a drop-
down list box next to the Limit 
to spectral technique label, 
where the desired technique 
can be selected and only 
libraries for that technique can 
be displayed in the upper part. 
The lower part of this window 
shows the selected libraries to 
be searched for the selected 
Search # X tab.  

Libraries can be added 
(highlight the desired library names in the upper 
area) and then Click on the   Add   button or deleted 
(highlight the name of the library to be removed in 
the lower area) and then Click on the    Remove   
button. 

Once this window is no longer needed, Click in the 
the Spectrum MS (GC) label at the top of the 
column to display the bar graph spectrum. This 
caused the spectrum in the SearchIt window to be 
displayed and the spectrum will reappear. The 
search of the spectrum displayed (selected tab) in 
the SearchIt window by Clicking on the   Search   
button on the lower right of the SearchIt window or 
the spectra in each tab can be searched by doing a 
Batch Search from the Main Menu’s Edit menu. 

After the spectrum (or a batch of spectra is (are) 
search the SearchIt window closes, and a tab 
appears at the bottom of the MineIt window with the 
label Hit List Search #X. Each Hit List is display by 
Clicking on the individual tab. The MineIt widow is 
divided into three sections. The vertical window 
(optionally displayed) is the Structure (if present) 
and the meta data for the library spectrum. The 
upper horizontal window contains the selected Hit 
List spectrum and the searched spectrum. The lower 
horizontal window is a display of the all the Hits, with 
a scroll bar. 



MS Library Search Settings 
The default Library Search settings will perform 
what is often referred to as a Normal Identity Search 
and should be used when it is possible that there is 
a spectrum of the same compound that produced 
the spectrum being searched in one or more of the 
selected libraries. 

The m/z value of each peak in the searched spectrum 
and its relative intensity is considered as is each peak 
in the library spectrum along with its relative intensity. 
By default, this Hit List is ordered based on the best 
match (HQI, hit quality index) regardless of which 
library the matched spectrum is in. 

The spectrum submitted for search can represent a 
Single compound, or a Mixture of 2 or 3 compounds. 
The type of spectrum is selectable in the drop-down 
list box under the Number of compounds: label. The 
default is 1 (Single). If it is believed that the spectrum 
is a mixture of two compounds, set this to 2 (Mixture) 
and if the spectrum is believed to represent three 
compounds set this to 3 (Mixture). When multiple 
matches are found in the searched libraries, the Hit 
List spectrum will be of a mixture and multiple 
structures and names will appear. 

This Search uses the Search Method Dot Product 
(Cosine) and the check boxes next to the labels 
Adaptive Search and Reverse Search are NOT 
selected. The drop-down list box below the Search 
Method label has three other selections. These can 
be ignored. Unless your level of mass spectrometry 
knowledge is high, this Default Search should be 
used most often. This is the same as the NIST Mass 
Spectra Search Program’s Normal Identity Search 
when using the default Limit Settings. The other 
three search types are explained in explained in 
more detailed KnowItAll documentation. 

If it is believed that there is no spectrum of the 
compound that produced the spectrum being 
searched, the Adaptive Search should be used. 
The Adaptive Search finds compounds that are 
similar to the submitted spectrum but have 
additional or missing fragments. This search is 
initiated by placing a check () mark in the box next 
to the Adaptive Search label on top of the SearchIt 
window with the spectrum displayed.  

Selecting the check box next to the Adaptive 
Search label results in a text entry box preceded by 
the label Molecular m/z: being displayed. The 
Adaptive Search requires that the nominal mass of 

the analyte be specified. If it is not, the software will 
try to assign this value. It is easy to do this when a 
molecular ion peak is present in the spectrum; 
however, if it is not, a soft ionization technique like 
CI or FI or derivatization should be used. If no value 
is entered, the search will be much slower, and 
results will possibly be poorer. 

The results of the Adaptive Search are displayed in 
MineIt window in the same way as an Identity 
Search, sorted by the HQI (Hit Quality Index) and 
the delta-mass (Δm [u]) value will be shown. The 
HQI reported is a special value determined by 
adding and subtracting peaks and suggested 
replacement fragments are described. This 
approach essentially extends the dynamic range of 
reference libraries by "hinting" at likely structures not 
found in the reference library. For example, an 
unknown compound with a methyl group on an 
aromatic ring would yield a very high adaptive HQI 
for a reference spectrum of a methoxy group of an 
aromatic ring. The delta mass (Δm [u]) of 16 for 
oxygen would be noted in the Hit List results for the 
methoxy library spectrum. In addition to the (Δm [u]) 
column in the Hit List item, there is a Δm info 
labeled column with the  symbol. Put the Mouse 
pointer on this symbol and Click the LMB once. This 
cause the Adaptive Corrections window to be 
displayed with three spectra stacked on top of one 
another (Query, Corrected Reference [Hybrid], and 
Uncorrected Reference [Library]). There are dashed 
lines from the abscissa of the Corrected Spectrum to 
the abscissa of the Uncorrected Spectrum to show 
what alterations were made to the Uncorrected 
Spectrum to produce the Corrected spectrum. A 
suggested structure can be drawn and associated 
with with the Queried spectrum to use with NIST’s 
Mass Spec Interpreter to see if the two make sense 
relative to one another. 

The Reverse Search option might be selected when 
doing a Normal Identity Search (the Adaptive 
Search box would not be checked). This is used 
when there is a possibility that the searched 
spectrum represents a mixture of two or more 
components. The Standard Identity Search is setup 
as described above. The difference is that the 
Reverse Search selection is checked. In MineIt, the 
Hit List is ordered according to the highest Reverse 
Hit Quality Index (R.HQI) value. If the searched 
spectrum represents more than a single compound, 
the best matches for each of the possible 
components will be at the top. The R.HQI is the 



same as the HQI except all peaks in the sample 
spectrum that are not in the library are ignored when 
the value is calculated. This way the same spectrum 
can have two very high R.HQI values, one for each 
of two compounds present. 
 

Hit List Size Limit 
On the lower left of the SearchIt window is the 
following display: 

 
You can use the Up/Down arrows to change the 
value in the box just to the right of the Hit List Size 
Limit Label or you can highlight the number and 
change it by typing a new value. For practical 
reasons, this should be between 50 and 100 when 
searching spectra. The All Hits check box should 
NEVER be selected. Selecting this can greatly 
prolong the search and adds no value. 
 
NOTE: The displayed spectrum in the bottom 
spectrum window of the ProcessIt window or the 
upper spectrum (that of Sample Spectrum) of the 
MineIt window can be sent to the NIST MS Search 
Program by selecting Edit from the Main Menu Bar 
and then selecting Transfer to NIST MS Search. 

 
MineIt window showing partial Hit List 

Customizing Window Displays 
The three KnowItAll windows worked with in 
GC/MS and MS Data Analysis are ProcessIt, 
SearchIt, and MineIt. The window displays can be 
customized in several ways. In the ProcessIt 
window put the Mouse pointer on the RTIC 
chromatogram or one of the graphic spectrum 
sub-windows, Click the Right Mouse button to show 
the RMB menu, and select Edit Properties (last 
selection on the RMB menu) This is a tabbed dialog 
box as shown to the 
left. Examine all the 
options, make your 
choice, and see 
what they can do for 
you. The Colors 
and Fonts tab has 
a drop-down list box 
just below the Item 
label, The selected item in this list will cause the 
contents of this tab to change, i.e., the ability to 
change a font size or type is only available if Peak 
or Axis numbering or a similar item that involves 
the displayed font is selected in the list.  

All selections are saved, even when exiting 
KnowItAll, until changed. 

The ProcessIt window has a button that turns the 
labeling of the m/z values of mass spectral peaks on 
and off in the button bar just to the right of the button 
with the + symbol. MineIt has two such buttons: one 
to label the Active Spectrum and the other button 
to label all spectra. They are to the right of the  
button. MineIt has buttons to change the view 
options of the Hit List spectrum and the sample 
spectrum. These can also be selected by choosing 
View from the Main Menu Bar and selecting the 
Display Mode from the View menu to display a 
second level menu. 

In the MineIt window, the Display Properties dialog 
box only pertains to the top half of the display that 
has the searched spectrum and the selected Hit 
List spectrum. 

The Hit List display has separate tools used for 
customizing the display. The height of the rows and 
width of the columns can be adjusted. Columns can 
be added and deleted as well as edited. 

To Adjust Row Height, put the Mouse pointer on 
the horizontal line between any two rows in the 
column with the Hit # (far left). The Mouse pointer 



changes to a . Hold down the LMB and pull down 
to make the row wider. Push up to make the row 
narrower. The height of all rows changes the same 
amount. 

To Adjust Column Width, put the Mouse pointer on 
the vertical line to the left of the the column’s width 
that you want to change, in the row that has the 
names of the columns. The Mouse pointer changes 
to a . Hold down the LMB and pull the pointer to 
the right to increase the width of the column on the 
left. Pushing to the left while holding down the LMB 
will decrease the column’s width. 

Additional columns can be added. Placing the 
Mouse pointer any place in the Hit List and Clicking 
the RMB, will result in the display of a RMB menu. 
The first item is Add Column. This causes a 
Choose Single Column dialog box to be displayed 
that has a drop-down list box with several items and 
a scroll bar so that all can be displayed. Highlight 
the item and Click on the OK button. The column 
with that header will be added next to the last 
column on the right. 

The second item is Insert Column. If the RMB 
menu is displayed when the Mouse pointer is on a 
specific column, the inserted item’s column will be 
placed to the left of that column. 

The other three items on this RBM menu are Delete 
Column (place Mouse pointer on Row to be deleted 
and Click LMB), Delete Row, and Edit Column, 
which allows you to change the column header.  

Unlike other display changes, Hit List display 
changes are NOT AUTOMATICALLY saved and 
even are not used when switching between Hit List 
in the MineIt window. The changes are saved to a 
Display Profile: 
(right edge of upper button bar of the MineIt 
window). The two buttons are for Add a New Profile 
(left) and Save a Current Profile (right). The 
dropdown arrow allows you to select a profile. 
Highlight the name of the desired Profile and it will 
be applied to the current Hit List when you Click the 
LMB. If you select the tab for another Hit List, you 
will have to re-select the Profile to have in applied. 
When the new Hit List is selected, the list box will 
read <no profile>. The Profiles are permanently 
saved and cannot be deleted. They can be edited. 

Importing Spectra in a Text Format 
Spectra do not have to be imported from 
chromatographic data. They can be imported from a 
text file as long as they are in the format described 
by NIST (the NIST MSP format). The extension of 
the file is not relevant. It can be TXT, MSP, or any 
other three-character string. 

Such spectra are imported when the SearchIt 
window is displayed. If KnowItAll is started from its 

icon (not already running), 
select the button labeled 
    Data    in the left vertical 
panel. Then select the SearchIt 
icon. This results in the display 
of the SearchIt window with the 
Library Selection window 
overlaid. If the desired library is 
shown in the bottom of this 
window, go to the next step. If 
not, make the appropriate edits 
to the Selected for Searching 
window. 

Next Step: On the far left of the upper button bar 
are two buttons. The 
Mouse-over label for 
the first is New 
Search and for the second is Open Spectrum or 
Structures. Select the second button. 

This causes the Open file dialog box to be displayed 
(shown below). 

 



Navigate to the location of the text file to be 
imported and highlight the file name by placing the 
Mouse pointer over it and Clicking the LMB ONCE. 
The preview window at the bottom of the Open file 
dialog box will show a spectrum which is a 
composite of all the spectra in the file and the name 
of each spectrum will also be displayed in a column. 
If this is the file you want, Click on the Open button 
(shown at bottom of previous page). 

 

NOTE 
The Open file dialog box can also be displayed by 
putting the Mouse pointer on the Spectrum label in 
the vertical panel to the left of the Library Selection 
window; however, when the display shown above 
appears, only a single spectrum can be imported to 
the SearchIt spectrum window at one time. 
Therefore, the Open file dialog box should only be 
displayed using the icon. 

************************************************************* 
A new window with two panes is opened on the 
upper left of the display (see above). The left pane 
has a list of all the names, with a check box (selected 
by default), of all the spectra in the file. The pane on 
the right shows a bar-graph of the selected spectrum 
(1st spectrum, by default). Putting the Mouse pointer 
on any name (not the check box) and Clicking the 
LMB ONCE, results in the spectrum for that name 
being displayed in the right pane. If the pointer is put 
on the the check box, and the LMB is Clicked once, 
the spectrum for that name is displayed and the 
check is removed for the box. 

The Microsoft Windows multiple item-select 
commands of LMB Clicked while holding the <Shift> 
or <Ctrl> Keys can be used to select or deselect 
groups of spectra. 

The window has Select All and Deselect All buttons 
as well as an OK and a Cancel button. 

After making sure that the check boxes next to the 
names of the spectra to be import have been selected, 
Click the OK button. This results in the Library 
Selection window closing, each spectrum with a check 
box being imported, and a tab with the spectrum’s 
name appearing at the bottom of display, which shows 
the bar-graph of the last spectrum imported. The 
bar-graph of any imported spectrum can be displayed 
by Clicking on the desired tab. 

All the imported spectra or one spectrum at a time can 
be searched. To search a single spectrum, display it by 
Clicking on the appropriate name tab and then Clicking 
on the Search button. To search all the spectra 
represented by the various tabs, select Edit from the 
Main Menu Bar, and Click on the Do Batch Search 
selection on the Edit menu. A dialog box is displayed. 
Normally you would Click on the Yes button. 

When one or all searches are complete, the SearchIt 
window will close and the MineIt window will be 
displayed with a Hit List for the last searched spectrum 
being displayed. If multiple spectra were searched, the 
display of each Hit List can be selected one at time by 
Clicking on the tabs at the bottom of the display. 

You may want to apply a Profile for the Hit List 
appearance (see information above). 

How To Create User-Databases 
User-databases are primarily created from *.MSP or 
*.SDF files. *.MSP files only contain text. *.SDF files 
can contain text and structures. 

When the MineIt window is displayed, Click the  
New Database icon 
(first icon on the 
button bar displayed under the MineIt label). This 
results in the display of the New Database Creation 
dialog box (shown below).  

 



Click the radio button next to the Create on local 
system label. Next, Click the Browse button. This 
results in the display of the Please Select Name 
and Location of the New Database dialog box 
(shown below). 

 

The mass spectral database being created will be 
created in the \This PC >Documents folder, by 
default. Type the name in the File Name text entry 
area at the bottom of the dialog box. The default 
extension of sdbx will automatically appended when 
you Click the Save button. The Select Name and 
Location dialog box is closed, and the New 
Database Creation dialog box comes into focus. 

The default Database Name in the New Database 
Creation dialog box is the same as was entered into 
the dialog box displayed by Clicking on the Browse 
button. Some other name can be entered, if desired. 
You should enter a short code (suggestion of no 
more than 3 to 5 characters) in the Database 
Abbreviation field. This field may not contain 
numbers or symbols. After you are finished with this 
New Database Creation dialog box, Click on the 
OK button. 

This results in a blank use-database in the MineIt 
view divided into three parts if the 
Structure/Properties window display is selected.  

Select File from the Main Menu, then select Import 
from the File menu, or use the Hot Key <Ctrl> + I. 
This will cause the Open dialog box with the preview 
pane to be displayed (shown below). You can select 
a *.MSP file or a *.SDF file. 

*.MSP file have a preview view as shown at the top 
of the next column. There is no Preview for *.SDF 
files. Select a *.MSP file. 

Once you are satisfied that you have selected the 
correct file to import, Click on the Open button. This 
results in one of two other displays. If the file contains 
multiple spectra, the Input of Multiple Spectra dialog 
box in the middle of the next column is displayed. 

The 
The 

check next to each the compound name means that 
spectrum will be imported. 

 

If you do not want some of the spectra to be 
imported, de-select that spectrum in the Spectrum 
to Import window. 

There are three radio buttons under the Spectrum 
import mode label. The Add all spectra to a single 
new record is selected by default. Change this to 
Add each spectrum to multiple new records. 
There are two radio buttons 
under the Property import 
mode label. If you know 
that there are field headers 
in the imported data that 
match Properties in 
KnowItAll, select Import 
Properties automatically. 
If you are unsure, select 
the other choice. Selecting 

File Open dialog box looking for *.MSP files 



Prompt Properties to impot will result in the 
display of the Properties Import Selection dialog 
box when you Click the OK button in this dialog box 
(shown at bottom of previous column).  

As seen in the Properties Import dialog box, the 
KnowItAll properties that correspond to those in the 
data being imported have check marks. Those that 
are not, don’t. Selecting one that is not checked, 
results in the opening of the Properties Field 
Definition dialog box (not shown). There are two 
choices: Link to existing field or Define as new 
field. It is best to look for an existing field. Click the 
down arrow on the right side of the displayed list 
box. This displays a long list of Properties. In this 
case, we are looking for correspond to a CAS 
registry number. Type “CAS” This will take you to 
the CAS Registry Number property. This causes 
the Properties Import Selection dialog box to be 
displayed and now there is a check make in CAS. 

This selection of a KnowItAll field being paired with a 
filed from the imported data is saved. The next time 
a file with a CAS field header is used, it will 
automatically be matched the KnowItAll Property 
CAS Registry Number. 

If the *.MSP file contains a single spectrum, the 
dialog box below is displayed. 

If values for the selected 
fields are in the spectrum 
file being imported, they 
will be imported with the 
spectrum. If there are 
un-selected fields and 
you select them, the 

Properties Field Definition dialog box (not shown) 
is displayed. This is delt with as described for *.MSP 
files containing multiple spectra. Clicking the OK 
button results in the spectrum being added as a 
record to the bottom of the database. 

If other meta data needs to be associated with 
record, this can be accomplished when you Click the 
Add button at the bottom of Structure/Properties 
window. This causes the Property Field Definition 
dialog box to be displayed. Select the meta data 
category and complete the information. Once edits 
are complete, Click on the OK button 

Structures are added via the link to ChemWindow. 
Double-click on the Structure window. Structures 
are added one at a time. 

Meta data and structures can be added from the 
PubChem Web site. Highlight the record to be 
updated in the lower part of the MineIt window and 
Click on the PubChem button                    in the 
Button Bar just below the MineIt label bar This will 
find the compound in the PubChem database on the 
Internet and allow the importation of the meta data 
and the structure to the record in the user-database. 
The button next to the PubChem button (just to the 
right) sends the selected spectrum/structure record 
to the NIST MS Interpreter program. 

If another spectrum is 
being added from a single-
spectrum file, How would 
you like to import 
spectrum? dialog box is 
displayed. The Add as a 
new record button is usually 
selected. After you Click this 
button follow the directions 
for adding a spectrum to a new database. The spectrum 
is added to the bottom of the database. 

The spectrum of a selected record can be sent from 
a user-database to the NIST Mass Spectral Search 
Program by Clicking on Edit in the Main Menu of 
MineIt and selecting the last item on the Edit menu, 
Transfer to NIST MS Search. The MS Search is 
brought into focus and if the NIST Autosearch is 
active, the spectrum is searched. To return to the 
MineIt display, Click on the Switch to Caller button 
in the button bar                                        of MS 
Search.  

The structure (if one is associated with the record) is 
not transferred with the spectrum to MS Search. To 
associate the structure with the spectrum in MS 
Search, use the MineIt Main Menu Edit selection, 
Copy Structure. This copies the structure to the 
Windows Clipboard. Use the <Alt> <Tab> command 
to switch the focus back to MS Search. In MS 
Search, select the Librarian tab at the bottom of the 
display. Highlight the name of the just transferred 
spectrum. Click on the Edit Spectrum button in the 
button bar. 

This will display a dialog box that has a button 
labeled From Clipboard. Click that button and the 
structure you put on the Clipboard in MineIt will 
associated with the spectrum. Click on the Replace 
button in this dialog box and the spectrum/structure 
pair will be in the Spec List of MS Search. 



One CAUTION: If the structure in KnowItAll has a 
phenyl ring with a circle rather than alternating 
double and single bonds, the circle will not be 
present in the imported structure in MS Search. The 
structure is imported as a cyclohexyl ring. Such 
structures should be edited in the ChemWindow 
function of KnowItAll before the association is 
made in MS Search.  

User-Libraries and SDF Files 
The terms user-databases and user libraries are 
somewhat synonymous. NIST user-libraries can be 
copied into KnowItAll user-databases. The NIST 
user-libraries can, and often do, have structures. It is 
important to remember, spectra can have structures 
displayed by one of two routes. The first, is to have 
a structure associated with the user-library 
spectrum. The second is to assign a Chemical 
Abstracts Services registry number (CASrn) to the 
user-library spectrum that is the same as an NIST 
library spectrum. If the user-library, with that CASrn, 
does not have an associated structure, the structure 
associated with the NIST spectrum having that 
CASrn will be displayed. Such displays will be 
referred to as pseudo-structure displays. 

To create a KnowItAll user-database from an NIST 
MS Search user-library, the user-library must be 
converted to a *.SDF file. This is done using the 
NIST Lib2NIST program which can be found on the 
NIST Database Start menu. The Lib2NIST.exe file is 
in the C:\NIST20\MSSearch\ folder. NIST user-
libraries are all located in this same folder. The user-
libraries will have a specific icon (     ) in the screen 
used to input the name of the user-library to be 
converted. The NIST user-libraries are folders with 
almost 20 or more different files. 

Important Note: Pseudo-structures in NIST 
user-libraries will not be transferred as SDF 
structures. These entries will have “No 
structure” in the SDF file. 

Once the NIST user-library has been converted to a 
a *.SDF (a single file with the same name as the 
NIST user-library folder in the and located in the 
C:\NIST20\MSSearch\ folder), follow the instructions 
above to create a blank KnowItAll user-database. 
Use the same name as the NIST user-library.  

The next step is to select the the *.SDF file for 
import by using the Import selection from the File 
menu of the Main Menu in the MineIt display. 

 

The above SDF Import Step 1 dialog box will be 
displayed when the *.sdf file is opened. Make there is a 
check the box next to the Add implicit hydrogens label. 

To continue the process, Click on the Next> button. 
This takes you to the Step 2 dialog box (not shown) 
which is matching the fields containing meta data in the 
*.SDF file with those for the Know-It-All user-database. 
As you highlight an SDF file field, examples of the field 
contents are displayed in the lower part of the dialog 
box. You can Click on the Suggest button to see if 
there is a match. If there is no match or the match does 
not look like a good match, Click the down arrow next 
to the list box on the right side of the dialog box. Look 
for what might be a match by typing a few of the first 
letters of the field list in the SDF file window. After 
finding a match, Click on it in the list to save it. 
Sometimes the selection will result in a check mark 
being in the box net to the Store as a numeric value 
label when it is not a numeric value like in the case of 
Comment, Formula, and Name. If this happens, make 
sure to un-check this box. 

In the SDF file list, there is a MASS SPECTRAL 
PEAKS. The suggested shows Gas Chromatogram. 
This is NOT what you want. You want MS Peaks List 
(this is the list of m/z intensity pairs) and is very 
important. Nominal Mass should be selected for the 
MW SDF file field.  

DON’T FORGET to Click on the SUGGEST button 
before searching the list for a corresponding filed. 

Once all the desired fields are matched (it is not 
necessary to match all fields in the SDF file), Click the 
NEXT> button. This imports the data into the KnowItAll 
user-database. A log will be display showing 
information such as which spectra did not have 
structures associated. See dialog box top of next 
column. 



 

When the Finish button is Clicked, you will be 
prompted to reindex the nascent user-database. It is 
a good idea to do this. 

User-Database Maintenance 
KnowItAll has a lot of tools to assist in the 
maintenance of User-Database. Many of these are 
found on the MineIt Main Menu Database selection. 

 

Both Records and Field Contents can be deleted. To 
delete records, highlight the record(s) to be deleted. 
Select Mark Record As Deleted from the Database 
Menu. This puts a check by this selection in the 
menu and an X make on a dark background in the 
user-databse Record No. Column. 

 

The next step is to select the Delete Marked 
Records from the Database menu. You will be 
asked if this is what you want to do. Click on the Yes 
button. 

The edited user-database can be reindexed by 
selecting Compact from the Database menu which 
results in the Database Compaction Parameters 
dialog box being displayed. 

 

The logical option might be to re-index stating at 1; 
however, if the Database number is used for 
evidentiary purpose, you may want to reconsider 
this.  

 



Random Notes 
More detailed training for KnowItAll can be found at: 
https://sciencesolutions.wiley.com/knowitall-
software-training-course/ You should Bookmark this 
URL. 

One of the Most powerful facts about KnowItAll is 
the fact that multiple files of the same type (GC/MS 
from nearly all vendors) and different types (IR, 
Raman, NMR, etc. From the same and different 
vendors) can be used at the same time.  

The default folder for KnowItAll temples and sample 
data files is: 
C:\Users\Public\Public Documents\Wiley\KnowItAll\. 
Sample files are found in \Samples\ 

 

The ProcessIt window with four separte GC/MS 
Data Files open. Each one can be brought into focus 
by Clicking on the tab. 

Right Mouse Button menu & Button Bar 
Many of the selections in the Button Bar are found 

on the Right Mouse Button (RMB) menu.  

The RMB menu when 
displayed in the RIC 
chorogram window of the 
ProcessIt window, has two 
selections that allow for 
Zooming: Horizontal Zoom 
Mode and Box Zoom 
Mode. The Horizontal Zoom Mode expands the 
abscissa (X-axis) and the Box Zoom expands both 
the x-axis and the y-axis (ordinate). There are four 
buttons used to control the display of overlayed 

EICs and the RTICC. These will be grayed when the 
Mouse pointer is in the Box Zoom Mode. They can 
made active by selecting another mode for the 
Mouse pointer (Horizontal Zoom, Select, UnZoom, 
or Pan). 

When the chromatographic display is Zoomed, the 
Pam Mode for the Mouse pointer is very useful. It 
allows a new section of the chromatogram display to 
be brought into focus. Click on the Pan Mode (     ) 
button. The Mouse Pointer now has this image. Hold 
down the left Mouse button and move the pointer 
from right to left or left to right to bring a different 
region into focus. 

Pasting Structures from NIST MS 
Search into ChemWindow 

When a structure is put on the Windows Clipboard 
using MS Search (MS Search's RMB menu 
command Copy Structure to Clipboard 
command), the Past selection in ChemWindow is 
grayed on its RMB menu and on the Edit menu 
selected from its Main Menu. However, if you select 
Edit from the Main Menu of ChemWindow and 
select Paste Special from the Edit menu and then 
select MOL text (Alt-Shift-Ctrl-P) from the Paste 
Special menu the structure is copied to the 
ChemWindow desktop. This works for NIST 
structures and NIST user-library structures. 

If the structure has a phenyl ring with a circle, it is 
replaced with a ring with alternating double and 
single bonds. 

If you do not have a Structure Drawing Program 
installed, when you install KnowItAll, ChemWindow 
will become the default Structure Program. Clicking 
on Default Structure Editor in the Send To menu 
of the NIST MS Search Program’s RMB menu will 
send the structure to ChemWindow from MS 
Search. 

More information on the use of KnowItAll for GC/MS 
can be found on James Little’s personal Web page: 

https://littlemsandsailing.wordpress.com/2022/09/01/
wiley-knowitall-mass-spec-training/ 


